Linux

on Bootable USB

in a MOE2 Environment

Dr Gary Jacobson


Business Education
and

Computing Department

Dalby State High School

Abstract

This practical paper describes how to set up a bootable USB stick with Fedora Core 11, or any other live, portable .iso image, with the recent addition of Persistent Overlays, so that the stick is essentially a computer-on-a-stick with resident hard drive capacity. This is a very useful change from the usual 'temporary' nature of 'live' Linux distributions on removable media. Installation of Apache Server, PHP PostgreSQL module and PostgreSQL server on the same USB device is described. This combination of software has significant application to the teaching of I.P.T. although the USB setup is easily adapted to any other Open Source software implementation as required. The final implementation is keyed to specific user credentials and can be used to connect to Home folders and other properly authenticated locations on a Windows (MOE2), or Linux server, without compromise of security. Students have a fully portable, consistent working environment from school to home, and anywhere there is a computer that can be booted from a USB device.

Rationale

Educators frequently and (often) loudly speak of providing students with a “variety” of learning modes and opportunities. They speak in good faith and attempt to do what is in their power to achieve this goal in their teaching practice. They also speak of educating students for the “real world” and working in the “real world”, as though, in this connection, the school was not part of the “real world”. However, it is apparent that both this goal and means of achieving it are sadly neglected in educating with, and about, computers in today's society. It is relevant and correct to state that the predominant operating system, Microsoft Windows, should be used in schools because this is the dominant desktop operating system and it is the associated application software the student will see in the work place, and which the student also uses at home. It is a sad indictment of the field that educators have not vigorously taken up, on a proportional scale, the alternative Open Source operating system Linux and its associated applications which are, in all major respects, the equal, or better, of Microsoft Windows and associated applications. In short, there has been no “variety” to speak of in operating systems at the desktop level and applications available for it, until perhaps the last 5 years, as Linux has matured and grown worldwide. The maturing of major applications within the Open Source world and the maturing of the Linux operating system itself now demand attention from educators everywhere as viable and important alternatives to proprietary systems. Students are taught to be “wise consumers” and “to shop around”, but not, of course, with computer software. They are offered, contrary to current law, in fact, only one choice when presenting to buy a new computer at the local emporium. This is because they, and society in general, suffer from simple ignorance of the alternatives. This “simple ignorance” is the result of a failing in education. Would any educator consider they had done a good job of teaching students how to buy a car by showing them only Holden branded cars running on Shell automotive products? In fact, making sure that this was the only combination of products available in the learning place! A highly unlikely scenario, and it is possible to envisage many other consumer-oriented examples of this type.

The failure of educators to implement Open Source solutions, at least in parallel with proprietary solutions, if not to replace them, is often explained away with the “...unfamiliar, unavailable, sub-standard, not supported, too complicated, ...” styles of argument. None of these 'arguments' can hold water in the present Open Source world. This situation is not improved by major authorities exclusively using Microsoft software throughout their infrastructure. In this connection, it should be recalled that IBM once dominated the computer software and hardware world before the advent of desktop computers, and that no system, however entrenched, or apparently part of the bed rock of society, is beyond change. This latter point is, of itself, something that students should be learning in the general pursuit of their academic lives.

Given that major authorities and employers are so enveloped in the Microsoft paradigm, it has to be said in defense of the educators of today, that the task of providing “variety” has been difficult. After all, if the entire workplace infrastructure is filled with proprietary software and there are so many other matters requiring attention that it is seemingly impossible to “buck the trend”. This is only seems so, since there are schools, everywhere in the world, that have converted their entire infrastructure to Open Source and Linux computing environments. In many cases this has been done to avoid the cost of proprietary software and in others a mixture of ideology and cost effective counter-measures has evoked change. What can be done within a large infrastructure, that uses a proprietary environment, to give our students an experience of another operating system and Open Source software in general? Until recently, it would seem to have been very difficult to introduce any parallel modes of computer operation either allegedly because of “security concerns”, (a complete nonsense), or because a desktop computer could run just one operating system at any given time, with any convenience. The latter meant that the computer had to have an alternative means of running another operating system (dual boot, terminal server or virtualization). The first two possibilities can be implemented within proprietary infrastructure with some difficulty and on-going management issues (e.g. reserving IP/MAC pairs, managing user accounts) and the latter (virtualization) is presently beyond the hardware capacity installed in most schools, and even given the rapid progress towards hardware improvement in schools, the proprietary work station software (Windows) used is not capable of supporting virtualization on the workstation itself and certainly takes no account of other operating systems, of whatever flavour, that may exist in the “real world”.

The solution to these problems for educators has presented itself in the form of one of the smaller hardware devices available – the USB “stick”. The advancing capacity of the USB flash drive (up to 64GB) and the ability of all desktop and laptop computers produced in the last 5 years to boot from USB devices means that all essential or required software, both operating system and applications, can be carried around in a shirt pocket. The last potential drawback, that of not being able to permanently store data on the same device as the operating system, which raises serious portability issues is now a thing of the past with the advent of “live” operating systems on USB devices with persistent overlays. This apparently small step forward makes it possible to implement the alternative computing environment anywhere, on any commodity computer and store data both locally as one would on a laptop or desktop and on a network device with appropriate authentication while providing a uniform computing environment from school to home in an even more accessible format than that of the “universal” Microsoft presence. In summary, the solution to implementing Open Source in proprietary infrastructure is available and it is up to educators to pick up this solution and use it!

Introduction

The present discussion and implementation will revolve around the use of a USB device of 8GB capacity. These commodity devices are readily available for $20 to $30, for reasonable quality, up to $50 for very rugged, faster types. Cost of hardware is, in short, not a barrier to implementation. USB flash drives of this size can be used to carry a “live” Fedora, Ubuntu or other similar operating system along with a very sizable selection of Open Source software, from a full office suite to database servers and web servers. The selection is not particularly constrained since an 8GB device will accommodate the O/S, a wide range of software relevant to your chosen tasks and a 4GB persistent data partition with ease. Larger, still relatively inexpensive devices, clearly give even more latitude with software implementation.

The teaching scenario to be addressed in this instance is that of teaching Information Processing and Technology in an Open Source environment; including the operating system.  The environment has to be uniform from home to school, flexible and comprehensive, being able to connect to network resources on either MOE2 (Windows) servers or Linux servers, with appropriate authentication, and still enable the student to carry the equivalent server (Apache, PostgreSQL, MySQL) around with them when not connected to the network. The requirements for I.P.T. Are along these lines: 

1. A command line interface (psql interpreter) to the PostgreSQL database server on the device to be used for “raw” querying of exisitng databases. This allows practice while constructing and using small databases and also allows for debugging when writing web interfaces that communicate with the database(s). 

2. A full Apache server implementation on the local device for testing PHP scripts, implementing, debugging and testing major and minor projects. 

3. A full PostgreSQL server implementation where the authenticated user can create and populate their own databases, users et cetera in conjunction with PHP-based interfaces.

4. A PHP.pgsql interface module for integration of the web and database servers.

5. A full featured text editor (Kedit, gedit) with syntax highlighting and general colour coding to allow easy script construction.

6. Full command line interface (console) for the user to become familiar with the various Shell commands should they so wish, or be required to do,

7. A full featured word processor (e.g. AbiWord) to enable complete documentation to be composed in a consistent way from computer to computer that can save in Microsoft formats (including .docx) for use under Windows if and as needed.


See Appendix A for a full list of the installed software in this implementation.

This environment is a full implementation of that found on the internal school Linux servers minus the Open Office packages and C++ development tools. It is possible to install binary rpms on the USB stick but not to compile source code, for example.

Creating a Bootable GNOME/KDE USB device

Hardware Requirements:   

1. At least one 8GB or 16 GB USB flash drive.

2. Desktop personal computer running either Windows or Linux
     (Ubuntu, Fedora, Debian).

Software Requirements:


1. Windows or Linux operating systems

2. “Live-USB-Creator” software package for the platform in use (approx 11MB download).

3. Appropriate “Live ISO” image (e.g. FEDORA 11 GNOME or
    KDE live, Ubuntu 9.04 Live ISO, Linux Mint, various 'custom
    spins), all available as downloads from various web sites.
    (Download size from 680MB to 1.5GB depending on selection).
    N.B. Store this on a hard disk that you can reach locally. This
            is simply a matter of access speed for such a large file.

Procedure : 

This procedure creates the basic, bootable, “liveuser” USB stick, using a Windows environment (just to show we're not totally biased!)

Unpack the liveusb-creator.zip file that you have downloaded. This will unpack to one sub-directory and 6 or 7 documents and executable files in the main directory (currently V3.6.7 for Windows). There is no “install” required and in fact I usually plug this in on a USB stick and run it from there. This has been successfully trialled on XP and Vista.
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What you see under Vista on a USB, just double-click the exe file:

Run liveusb-creator and you see this interface:
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Set Up Procedure:

1. Simply browse for the “live” .iso image file you previously downloaded, to a local hard disk(!), you don't want to copy 688 MB or more from a USB stick!

2. Set the size of persistent storage you require: let's say 4096MB on an 8GB stick

3. Select the correct 8GB USB as your 'Target Device' – don't overwrite a non-blank stick!

4. Click 'Create Live USB' to run a checksum on the.iso and start the installation. About 3 minutes to install the 'live' image and about 7 minutes to create the persistent 4GB overlay. Yes, bigger overlays take proportionally more time and smaller ones less time.

WARNING: Do not run multiple instances of this executable under windows and try to create multiple bootable sticks from the same .iso image simultaneously (e.g if you have four USB ports on a hub). Windows (using XP, or Vista) does not cope well and we have a faster way to make multiple copies of the finished product later anyway under Linux which does multi-task properly.

The interface and procedure for creating the bootable 'live' stick is the same under Linux with the same GUI as Windows. It's all fully cross-platform, so please yourself which platform you use to create the initial live USB.

Once this USB device is completely setup, make sure your computer is set to boot from USB in the B.I.O.S. Plug in the new stick you've built and re-boot. A modern, Core 2 Duo machine will typically boot to the 'liveuser' interface in around 30 seconds. Very old machines (> 5 years) that can boot from USB will boot to the login prompt in around one minute and 20 seconds, but I guess there's very few of those still around!

Initial Set-Up Procedure:

The Live USB device as is produced above is not really suitable for use in a secure environment. It has auto-login enabled and clicking 'liveuser' logs anyone in to the device/machine immediately. There's a little more work to do yet! Proceed as follows for the GNOME interface:

1. Log in as the 'liveuser'

2. Use Applications -> System Tools -> Terminal to open a console.

3. Type su – (that's su followed by a space followed by a 'minus' sign) and <ENTER>. You will be given a root user prompt (#).

4. Invoke the password change utility by typing passwd at the prompt.

5. Provide and confirm the new root user password. Don't forget it or you'll be creating another stick very shortly!

6. Click System -> Administration -> Firewall and Disable the Firewall. You will need to enter your newly created root user password to do this.

7. Click System -> Administration -> SELinux and set the Default Enforcing Mode to Disabled.

N.B. You might want to take a different approach to this outside the school Firewall and tell students to enable the firewall if using this set up on a system exposed to the Internet. Even with no Firewall it will still be 'safer' than a Win box, of course.

8. Click System -> Administration -> Users and Groups. You will be asked for your root user password again. Add a generic user (e.g. user) and set a well known password for this user. It's a password that will be changed by your students anyway.

9. Log out of the system as 'liveuser' and log back in as the generic user that you just created.

10. Click on System -> Administration -> Users and Groups. Provide the root user password when asked. Use the Users and Groups utility to Delete the 'liveuser'. This achieves our goal of allowing only an authenticated user on to the system at any time. Now, to deal with the 'auto-login feature' of the 'live' USB stick.

11. Open a Terminal (Applications -> System Tools -> Terminal) and use 'su' to become the super user. Run vi. Edit /etc/gdm/custom.conf to look like this:

# GDM configuration storage 

[xdmcp] 

[chooser] 

[security] 

[debug] 

[daemon] 

TimedLoginEnable=false 

#TimedLogin=liveuser 

TimedLoginDelay=60 

AutomaticLoginEnable=false

As you can see, this comments out the TimedLogin event and disables auto-login. Under KDE you edit the equivalent file for KDM and under other Linuxes you find it for yourself! If you don't like using vi or vim then use a GUI editor but you'll be running that with ordinary user privileges and so you'll have to chmod the file permissions or run the GUI editor using sudo to acquire enough read/write access. Please yourself how you do this, but do it.

At this point it is a good idea to re-boot the system using this stick and test that it does perform as we expect – no liveuser, no autologin, no timed login (wait for 60 seconds and see). If this al works then we are ready to put the software with which we would like to customise the installation in place. This might be just Open Office or it might be the server packages for I.P.T. As previously described.

A Custom Installation for I.P.T.

Download the following packages for installation under Fedora Core 11 (or their equivalents under Ubuntu, Debian or your chosen distribution):


Web Administration Tool for the entire system

webmin-1.480-1.noarch.rpm


PostgreSQL server and interpreter specific packages

postgresql-libs-8.3.7-1.fc11.i586.rpm

postgresql-server-8.3.7-1.fc11.i586.rpm

postgresql-8.3.7-1.fc11.i586.rpm


PHP interfaces and interpreters

php-common-5.2.9-2.fc11.i586.rpm

php-cli-5.2.9-2.fc11.i586.rpm

php-5.2.9-2.fc11.i586.rpm

php-pgsql-5.2.9-2.fc11.i586.rpm

php-pdo-5.2.9-2.fc11.i586.rpm

Apache Server should be already installed under Fedora 11 with GNOME as standard, but check this with /etc/rc.d/init.d/httpd status. The reply should be 'running' or 'not running' but there should be a reply.

Install as follows from a terminal prompt as root user:


rpm -i <package name>

Install the packages in the order given above and all should go well, if you install them out of order you will receive a dependency notice identifying the packages to install first anyway.

Once this is complete you have all the servers and administration tools necessary to complete the custom set up of this device for I.P.T. Teaching with PHP and PostgreSQL. A similar package installation would apply for MySQL, Open Office and whatever else yo may have in mind, of course. Recall that we only have about 4GB of disk though.

Check the Servers

To check the Apache server, just run Firefox and the Apache Home Page should load immediately (you may get an offline message, so use the File Menu selection to switch to online mode). Generally Apache will set itself up with the localhost IP by default and you won't have to edit httpd.conf. N.B. To make the Apache server load user files from a directory called public_html (default) you need to edit /etc/httpd/conf/httpd.conf as root user using vi and set up the file from about line 346 to 361 as follows:

<IfModule mod_userdir.c> 

    # 

    # UserDir is disabled by default since it can confirm the presence 

    # of a username on the system (depending on home directory 

    # permissions). 

    # 

#    UserDir disabled 

    # 

    # To enable requests to /~user/ to serve the user's public_html 

    # directory, remove the "UserDir disabled" line above, and uncomment 

    # the following line instead: 

    # 

    UserDir public_html 

</IfModule>

This, as noted in the file, is not advisable in an open Internet live web server. We use the UserDir option here because such a security issue does not exist and this is the easiest thing to do. You can also edit this file using Webmin if you like.

To check the Webmin tool, run Firefox to load http://localhost:10000 and use the root user password to log in to webmin. The browser will start in offline mode so check this if you do not receive the standard warning. You will find PostgreSQL under 'un-used modules, if it is not under 'Servers' already. Just Click on 'Refresh Modules' after PostgreSQL has been installed, in the left margin, to move this server entry point to 'Servers'. You can start the PostgreSQL server using Webmin ->Servers if you like or using




 /etc/rc.d/init.d/postgresql start 

You may need to use service postgrresql initdb on the command line to initiate the PostgreSQL database server if you choose not to use Webmin. You will need root user authority to execute all these commands whichever way you choose to run them.

N.B. For these servers to start every time, by default, when the system is booted form this stick, run 




chkconfig httpd on




chkconfig postgresql on

to automatically configure strat up for each for runlevels 3, 4 and 5. These commands require you to be the root user in a terminal/console window. There are other methods of doing this, but the command line is by far the simplest.

Generic User Setup

A generic user was placed on the system when we did the initial set up and deleted 'liveuser' as you recall. We need to make a few customizations for this user so they are able to load PHP pages sensibly through the Apache server from their Home directory/folder. Once again, this is not what one would do for a live web server perhaps, since it reveals which users are actually on the system to anyone who knows how to look. In our case thought, this is hardly a significant risk behind the corporate (school) firewall.

Create a 'Web Home' directory for the user by doing the following:

1. Double click on <User Name> Home folder on the desktop to open the generic user's Home folder.

2. Right click on the white space in that folder. 

3. Select Create Folder from the context menu. An untitled folder will pop up.

4. Type public_html in this name space as the name of this folder. This name must match the default public_html name we placed in httpd.conf.

5. Set the permissions on this directory to rwx for the user, whatever you think suitable for the Group (e.g. rx) and read-only (or even just x), for the rest of the world. You can set these permissions from the GUI by right clicking on this folder, or you can use something like chmod 751 public_html on the command line. This is 'your folder' as 'user' so you don't need to be root to set permissions on it. You do need to allow sufficient permission for the Apache server to actually read the file and run the file!

Basic PHP/Apache Testing

Create a test file called info.php using gedit (Applications -> Accessories -> Text Editor) and place it in the /home/user/public_html directory/folder that you just set up. In this file, for a start, put:




<?php





print(phpinfo());




?>

This will, if it runs through Firefox correctly, return a lot of information about PHP and its communications with both Apache and PostgreSQL servers. Scrolling down the page in Firefox you should references to both the pgsl and mysql modules

Start Firefox and type the address:



http://localhost/~user/info.php
You should see a lot of information about PHP Version 5.2.9 if you installed the latest Fedora 11 modules as per previous instructions in this document. If this looks alright then we have the Apache server, user Home and PHP running and some indication that PHP should connect to the PostgreSQL server properly. To test and set up a little more, we need a simplistic database with a at least one table with our generic user having access, so we can connect to it an test the database interfacing functionality of PHP. 

N.B. For teaching purposes, it is nice to see the errors that the interpreter will 'throw' when a syntax error is made. PHP is not set up by default to do this. If you want the interpreter to report the error and line number of the error then you need to edit /etc/php.ini. Do this by becoming the root user (su) at the command line and vi /etc/php.ini. Find the lines that looks like this (about line 369 in the file) :

; To output errors to STDERR with CGI/CLI:              

;display_errors = "stderr" 

; 

; Default 

; 

display_errors = on

You will see that this is normally, when you first read it off. Just edit to display_errors=on and save the file! The PHP interpreter will now report all errors made that it is able to detect at run or compile time.

Create a Simple PostgreSQL Database for Testing

Make it easy on yourself. Do the following:

1. Start Firefox and enter http://localhost:10000 and use Webmin. Use the root user ID and password to login.

2. Click on Servers in the left margin. You should PostgreSQL Database Server listed. If not go to Un-used Modules and look there. If it's still listed there, click Refresh Modules to move it into the Server listing. If this does not work then you may not have PostgreSQL installed correctly.

3. Click on PostgreSQL Database Server in the Servers listing. You should see generic databases present entitled 'postgres', 'template0' and 'template1'.

4. Click on Create a new database just above these listings.

5. The dialogues are self explanatory, but remember to set up the generic user as the 'owner' of the new database.

6. Once the database is created, click on it in the top level listing and create a table in that database. Enter some simple data. This is just a test, not “for real”.

7. Return to the PostgreSQL database Server main screen. Click on PostgresQL Users. 

8. Click on Create a new user and enter the generic user's name. Give the generic user the right to create databases and create users. Save this setting.

9. Once this is complete, click on Granted Privileges in the PostgreSQL database Server main screen. You should see your new database listed here. 

10. Click on the name of your test database (e.g. cars) and give the generic user whatever rights (SELECT, UPDATE...) you choose, but a minimum of SELECT!

11. Click on Allowed Hosts in the PostgreSQL database Server main screen. 

12. Click on Local Connection in the listing presented.

13. Click on No authentication required in the Authentication section making sure that Local connection is the connection being set up (top of screen).

Having completed all these steps correctly, you should be in a position to return to the info.php file created earlier and add some database interfacing (in PHP) to test access to this database. The following expanded info.php wil be useful:

<?php 


//print(phpinfo()); 


$link=pg_connect("dbname=cars user=generic_user_name"); 


$query = "SELECT * FROM CARS"; 


$result = pg_exec($link,$query); 


$num_rows = pg_numrows($result); 


for($row=0;$row<$num_rows;$row++) { 



$current_row = pg_fetch_array($result,$row); 



print($current_row[1]); 


} 

?>

Note that you will need to edit the line $link= to reflect the name of the database and the name of the generic user. You should see some simple output from your database tables. If php.ini was edited to show all errors you might also see just a series of database connection errors if you have set the database permissions incorrectly, or committed and error of syntax. In that case you will need to re-visit your PostgreSQL database set up using Webmin.

Whew! What a job!

Good Grief!!
Don't tell me I have to do all  this for every user !!!!!!!!!!!

No – You don't

Read On!

Cloning the USB Stick

Aren't you glad we can do this? Especially if you have to set up a few dozen or a few hundred for things that are not I.P.T. This method of cloning is not the only one possible I'm sure, but it works nicely under Linux (tested with Fedora 9, 10, 11 and Ubuntu), is reasonably quick and you do not have sit around and watch once you start the process.

Hardware: 


1. The bootable USB stick you have just laboriously customized for

your purposes.

2. Any number of other USB sticks with FAT32 factory format or
 
other FAT 32 format (this will be overwritten of course). These
 
sticks need not all be 8GB, but they should be that size, or larger,
 
for safety. Everything has to fit on it!

Procedure:

Create an master image of your customized 'live' USB stick on a local hard drive. This is a large, raw data copy and moving it over a network will only slow down the whole process of creating the image as would copying it back from a USB stick. Make sense? If you have not used dd with Linux before then do this on a non-critical machine in case you destroy the whole hard disk image!

1. Plug in the customised USB stick on the machine you want to store the image on.

2. Start a terminal session and become the root user.

3. Type mount to view the current mounted file systems. You should see the USB device you just plugged in as something like:  



/dev/sdf1 on /media/<vol_name> type vfat (rw, ......blah, blah,...)

4. This could be anything from /dev/sdb1 to sdh1 depending on how many usb ports are occupied or present on the machine, so check that volume label carefully or you'll be trying to copy from a usb printer or modem or something, and that, will not work!

5. Create a folder on the hard disk called /home/user/bring_in_the_clones (for example). Use the GUI to do this sine you'll be writing to it with root user privileges.

6. Type (very carefully and check it) the following format of command (for example):


dd if=/dev/sdf1 of=/home/user/bring_in_the_clones/<filename you choose>


where if= is the input file specification and of= is the output file specification.

Roughly 8 to 10 minutes is required to clone the entire stick on a Q8200 (Core 2, Quad) machine with 4GB of RAM. Since you are running this as root user from the command line the resulting file is only read/write for the root user.

7. Remove the master usb stick from the machine. Check /home/user/bring_in_the_clones to see that you have a file around 7.5GB to 8GB present with the name you specified in the initial command above.

Creating the Clones 

It is possible to create multiple clones on the one machine simultaneously under Linux if yo have the necessary USB ports available. You simply need to issue commands for the different devices on the command line independently (or write script to do this for you). On a 4GB, Q8200 Core 2 Quad machine it was possible to clone 3 or 4 sticks simultaneously over ~14 minutes. Similar results are achievable with a USB hub.

How to create a clone:

1. Plug in the usb target stick. A blank, FAT32 formatted stick, that is.

2. Run a terminal session, become the root user and execute a mount command to check where you usb stick (or sticks) is/are mounted (see previous procedure above). You should see one or more /dev/sdxn type entries depending on how many sticks are plugged in at one time.

3. Execute the following as root user on the command line:

dd if=/home/user/bring_in_the_clones/<filename> of=/dev/<device_from_mount_table>


DON'T GET THIS BACKWARDS or you'll be recreating your image file presently!

Example:    
Cloning the master file to three sticks on one machine would require three

 
commands like this,

dd if=/home/user/bring_in_the_clones/my_gnome_stick of=/dev/sdh1

dd if=/home/user/bring_in_the_clones/my_gnome_stick of=/dev/sdf1

dd if=/home/user/bring_in_the_clones/my_gnome_stick of=/dev/sdg1

You can see that these commands only differ in the device specification for the target as you would expect. This could easily be scripted or otherwise automated further. If you have hundreds to do yo might consider commercial duplication of sticks and contents or buying a device that performs cloning through hardware means.

Almost There!

You now have a number of clones that you should test such that, when you log in as the generic user, you can carry out PHP programming activities as expected along with all other normal software functions. If all is well, then you can proceed to customising sticks for each user you want to supply with a certain image as follows:

1. Boot the system with a cloned stick.

2. Log in as the generic user. Thank God you haven't forgotten the 'well known' password that you set in the beginning :0 !!

3. Click System -> Administration -> Users and Groups . You will be asked for the root user password.

4. Enter the username, real name, password of the person to whom this stick is to be issued.

5. Delete the generic user and delete their Home folder or change ownership on that folder so it is accessible only to the root user.

6. Log out and log back in as the newly assigned user of this stick (just checking).

7. Delete the old generic users home directory and chmod 711 /home/<new user>

8. Create a public_html directory for the new user in their newly created Home folder.

9. Use Webmin to create a new PostgreSQL user with the same ID as the new owner of this stick.

10. Use Webmin to change PostgreSQL database server permissions for the new user of this stick.

11. Check that the new user is able to run PHP (info.php for example) and has correct database access.

12. Done.

Accessing the Network(s)

Let's assume that you have a user who has just booted a computer from one of these USB sticks. Let's suppose this computer is normally part of the MOE2 Domain at your school, or other Windoze Domain at your school. What can the user do?

Mount Local Partitions/Drives

No, but, by clicking Places, the user will see the local Windows disk partition or partitions. If the user had root access they could mount these partitions and access the data on them. They cannot do that, of course, because the root password is unknown to them. In any case, in the school environment, there should be no data of any worth on the workstation hard drive, should there?

Connect to Windows Home Folder (Mount Windows network shares)

Yes, by clicking Places -> Connect to server, the user invokes a dialogue that will allow them to connect to the Domain server where (presumably) their Windows Home Folder exists. To access this they need to select Windows share as the Service Type and they need to know the name, or IP, of the server, their username for Windows and their logon password for Windows. They need to know that the Folder to connect to is <username>$ in the usual Windows convention. This gives them access to transfer data only with the usual privileges allowed to ordinary users on the Windows side. They can transfer data from their Home on the Linux stick to the Windows server Home and vice versa.

Connect to Linux Home Folder (Mount Linus network shares)

Yes. A student doing I.P.T. at Dalby SHS is required to keep copies of all PHP files in the Linux Home drive on a local Linux server as well as on the usb stick. Connecting to the Linux Home Drive is similar to the connection to a Windows Home share but done with a Service Type of SSH (secure shell), the folder name on the server is something like /home/<username> and the usrname for the connection is their normal Linux username. The connection requires them to supply their Linux password to connect. Privileges are those of an ordinary user on the Linux server.

Run SSH Shell Manually

Yes. The student can invoke something like ssh <server_name> and, if they exist as a user on that machine, will be bale to supply username and password to logon in a secure shell and execute commands like psql cars (for example) to invoke a direct query session of the database 'cars' (if it exists and they are PostgreSQL users on that machine. This can prove useful in testing queries on a 'remote' database when the PHP interface is throwing errors that appear to be database related.

Run all Local 'Stick' Software

Yes,of course, except that which requires root user privileges (like loading Linux to a hard drive, mounting hard drive or network partitions locally, etc). Including, if it was included, an Open Office Suite, Graphics tools, Internet tools/browser, Games (!@#@!), et cetera. No limitations. The environment remains similar from machine to machine wherever the stick is used to boot the machine.

Performance

Performance is, as you would expect, processor and RAM dependent to an extent. This implementation has been tested on machines with 256MB of memory that are 7 years old and were among the first to  provide USB boot capability (USB 1.0). It has to be said that the boot performance, in these instances, is slow (over 1 and a half minutes) and that the running performance is noticeably slower than on a modern machine. Is anyone using such a machine in a school these days? I didn't think so. 

On a modern HP desktop with Duo Core (AMD) processor and 1GB RAM, boot time is about 30 seconds and general performance is no different to hard disk operation most of the time since applications load relatively quickly (hardly distinguishable from normal) and when R.A.M. resident operate as quickly as usual. More memory makes life easier, of course. Performance on laptops is very good if the laptop was built in the last 3 years or so. Testing on 4-5 year old Optima machines with P4 and 512MB RAM gave acceptable boot times of around 1 minute and sufficiently fast in memory performance and loading performance to be easily usable for any productivity task including Graphics editing. In summary, use this technique and these sticks in newer machines and “life” is normal.

Conclusion

It is clear that we need no longer accept the 'harness' of a Microsoft-only world in education. The equivocations over cost, portability and standardization of environments no longer apply. We should be offering our students true variety in the learning environment in the computer software arena as well as the more traditional sense.
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